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Preface

This document describes how to use OPatch to patch an Oracle Fusion Middleware
environment.

Audience
This document is intended for administrators who are responsible for patching Oracle
Fusion Middleware.

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an action, or
terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which you
supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in examples,
text that appears on the screen, or text that you enter.

v





1
Patching Your Environment Using OPatch

The OPatch utility provides several commands that you can use to apply and roll back
patches to Oracle software in your Oracle Fusion Middleware environment.

For more information about using OPatch commands in an Oracle Fusion Middleware
environment, see the following topics:

See Also:

About OPatch
OPatch is a Java-based utility that runs on all supported operating
systems and requires installation of the Oracle Universal Installer. It is
used to apply patches to Oracle software.

Preparing to Use OPatch
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatch, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the Oracle home.

Using OPatch to Patch Oracle Fusion Middleware
Use OPatch to perform the necessary steps for applying a patch to an
Oracle home.

1.1 About OPatch
OPatch is a Java-based utility that runs on all supported operating systems and
requires installation of the Oracle Universal Installer. It is used to apply patches to
Oracle software.

The following topics provide more information about OPatch for Oracle Fusion
Middleware:

See Also:

Patching Your Environment Using OPatch

Type of Patches Used with OPatch
Oracle provides several types of patches that you can use to patch your
Oracle software with OPatch.

Information for Oracle WebLogic Server Smart Update Users
Smart Update is a standalone Java application that you use to upgrade
the software installations quickly and easily with maintenance patches
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and maintenance packs. For Oracle Fusion Middleware 12c, Smart
Update is no longer supported.

1.1.1 Type of Patches Used with OPatch
Oracle provides several types of patches that you can use to patch your Oracle
software with OPatch.

Note:   

Oracle has recently implemented a new patch nomenclature for Oracle
products. The new patch names, as well as the previous Oracle Fusion
Middleware 11g names, are provided for reference.

Table 1-1    Patches that can be used with OPatch

New Name Previously Used Name(s) Description

Interim Patch PSE

MLR

Exception release

One-Off

x-fix

Hotfix

Security One-Off

A patch containing one or more fixes
made available to customers who
cannot wait until the next patch set
or new product release to get a fix.

Bundle Patch Maintenance Pack

Service Pack

MLRs

Cumulative Patch

Update Release

Bundle Patch

An iterative, cumulative patch that is
issued between patch sets. Bundle
patches usually include only fixes,
but some products may include
minor enhancements. Examples are
the Database Windows Bundles and
SOA Bundle Patches.

Security Patch Update (SPU) Critical Patch Updates

CPUs

An iterative, cumulative patch
consisting of security fixes. Formerly
known as Critical Patch Update.

Note: The program name which
delivers SPUs will still be called
Critical Patch Update, as defined
below:

Critical Patch Update: Oracle's
program for quarterly release of
security fixes. Patches released as
part of this program may be Patch
Set Updates, Security Patch Updates,
and Bundle Patches. Regardless of
the patch type, the patches are
cumulative.

About OPatch
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Table 1-1    (Cont.) Patches that can be used with OPatch

New Name Previously Used Name(s) Description

Patch Set Updates (PSU) Patch Set Updates are used to patch
Oracle WebLogic Server only. Patch
Set Updates are released on a
quarterly basis, following the same
schedule as the Critical Patch
Updates (CPUs). These come out the
closest Tuesday to the 15th of the
months of January, April, July and
October. Patch Set Update content is
intended to address the top fifty
critical bugs affecting the broad
customer base.

See Also:

About OPatch
OPatch is a Java-based utility that runs on all supported operating
systems and requires installation of the Oracle Universal Installer. It is
used to apply patches to Oracle software.

1.1.2 Information for Oracle WebLogic Server Smart Update Users
Smart Update is a standalone Java application that you use to upgrade the software
installations quickly and easily with maintenance patches and maintenance packs. For
Oracle Fusion Middleware 12c, Smart Update is no longer supported.

In previous releases of Oracle WebLogic Server, you could patch your Oracle
WebLogic Server software using a utility called Smart Update. In Oracle Fusion
Middleware 12c, Oracle WebLogic Server users can use OPatch to apply patches for
both Oracle WebLogic Server and for Oracle Fusion Middleware.

OPatch offers many of the same features as Smart Update, but it has a different set of
commands and command options. Oracle WebLogic Server users who are familiar
with Smart Update should use this guide to get familiar with OPatch.

See Also:

About OPatch
OPatch is a Java-based utility that runs on all supported operating
systems and requires installation of the Oracle Universal Installer. It is
used to apply patches to Oracle software.

1.2 Preparing to Use OPatch
To ensure successful patching, there are several prerequisites you should complete to
prepare your environment for running OPatch, such as obtaining the latest version of
OPatch, obtaining required patches from My Oracle Support, and backing up the
Oracle home.

For more information on preparing your environment, see the following topics:

See Also:

Patching Your Environment Using OPatch

Preparing to Use OPatch
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Locating and Obtaining the Latest Version of OPatch
Before you run OPatch, find the OPatch utility in the Oracle home, and
verify that you have the latest version.

Obtaining Patches Required for Your Installation
You can search for and download the patches required for your
installation from My Oracle Support.

OPatch Environment Variables for Fusion Middleware
Before you run OPatch, ensure that you set the ORACLE_HOME
environment variable.

Backup and Recovery Considerations for Patching
It is highly recommended that you back up the Oracle home before any
patch operation. You can back up the Oracle home using your preferred
method.

1.2.1 Locating and Obtaining the Latest Version of OPatch
Before you run OPatch, find the OPatch utility in the Oracle home, and verify that you
have the latest version.

For more information, see the following topics:

See Also:

Preparing to Use OPatch
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatch, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the Oracle home.

Locating and Running OPatch in the Oracle Fusion Middleware Oracle Home
You can find and run the OPatch utility in the ORACLE_HOME/OPatch
directory after you install any Oracle Fusion Middleware product.

Identifying the Version of OPatch Included with Oracle Fusion Middleware 12c
Oracle Fusion Middleware 12c (12.2.1) includes OPatch version
13.3.0.0.0. This version includes new features and capabilities that are
designed to improve the experience of patching an Oracle Fusion
Middleware 12c Oracle home.

1.2.1.1 Locating and Running OPatch in the Oracle Fusion Middleware Oracle Home
You can find and run the OPatch utility in the ORACLE_HOME/OPatch directory after
you install any Oracle Fusion Middleware product.

To run OPatch, simply run the opatch command in this directory.

For example, to view the list of commands available for OPatch on a Unix system,
enter the following:

./opatch -help

On Windows systems, use the following command:

opatch.bat -help

Preparing to Use OPatch
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See Also:

Locating and Obtaining the Latest Version of OPatch
Before you run OPatch, find the OPatch utility in the Oracle home, and
verify that you have the latest version.

1.2.1.2 Identifying the Version of OPatch Included with Oracle Fusion Middleware 12c
Oracle Fusion Middleware 12c (12.2.1) includes OPatch version 13.3.0.0.0. This version
includes new features and capabilities that are designed to improve the experience of
patching an Oracle Fusion Middleware 12c Oracle home.

In general, there is a version of OPatch available for each version of the Oracle
Universal Installer software.

To identify the version of OPatch:

1. Change directory to the following directory:

cd ORACLE_HOME/OPatch/

2. Run the following command:

./opatch version

For example:

./opatch version
OPatch Version: 13.3.0.0.0

OPatch succeeded.

See Also:

Locating and Obtaining the Latest Version of OPatch
Before you run OPatch, find the OPatch utility in the Oracle home, and
verify that you have the latest version.

1.2.2 Obtaining Patches Required for Your Installation
You can search for and download the patches required for your installation from My
Oracle Support.

You can check for the latest patches available for your Oracle Fusion Middleware
product or component by registering and logging in to My Oracle Support at:

http://support.oracle.com

After you log in to My Oracle Support, click the Patches and Updates tab, which
provides various tools that allow you to quickly locate the patches most important to
your Oracle software installation.

Note:   

It important that you review the README file that is included with each
patch. The README file includes important information about the
requirements and procedures for applying the patch.

Preparing to Use OPatch
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See Also:

Preparing to Use OPatch
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatch, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the Oracle home.

1.2.3 OPatch Environment Variables for Fusion Middleware
Before you run OPatch, ensure that you set the ORACLE_HOME environment
variable.

OPatch uses the ORACLE_HOME environment variable to identify the Oracle home
you are planning to patch.

See Also:

Preparing to Use OPatch
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatch, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the Oracle home.

1.2.4 Backup and Recovery Considerations for Patching
It is highly recommended that you back up the Oracle home before any patch
operation. You can back up the Oracle home using your preferred method.

You can use any method such as zip, cp -r, tar, and cpio to compress the Oracle
home.

If the Oracle home does not appear when you execute the opatch lsinventory -
detail command, the Oracle home might be missing from the Central Inventory, or
the Central Inventory itself could be missing or corrupted.

If the Oracle home is listed when you execute the opatch lsinventory -detail
command, but the products and components within the Oracle home are not listed,
the inventory within the Oracle home (local inventory) might be missing or corrupted.

If the local inventory is corrupted or lost for some reason, you must restore the entire
Oracle home if it was backed up. If a backup does not exist, you may have to reinstall
the software.

See Also:

Preparing to Use OPatch
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatch, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the Oracle home.

1.3 Using OPatch to Patch Oracle Fusion Middleware
Use OPatch to perform the necessary steps for applying a patch to an Oracle home.

The following topics describe how to use OPatch to patch Oracle Fusion Middleware:

See Also:

Patching Your Environment Using OPatch
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Summary of the Steps For Using OPatch in a Fusion Middleware Environment
Applying a patch with OPatch involves a series of steps that must be
performed to ensure successful patching.

Common OPatch Commands When Patching an Oracle Fusion Middleware
Oracle Home

OPatch provides several commands that you can use to apply a patch,
roll back a patch, and verify the application of patch in an Oracle home.
You can use OPatch to apply and roll back a single patch or apply and
roll back multiple patches.

Examples of Applying and Rolling Back Patches Using OPatch
After you obtain the patches required for your installation, use the
appropriate OPatch commands to verify any patch prerequisites, apply a
patch to an Oracle home, and if necessary, roll back the application of a
patch.

Troubleshooting a Patch by Viewing the OPatch Log File
To understand how a patch is applied and to troubleshoot any problems
with the application of a patch, you should review the log file for the
OPatch session.

Using the OPatch lsinventory Command to Verify the Patches Applied to an
Oracle Home

To verify what patches have been applied to an Oracle home, or to find
out additional information about the Oracle home, use the opatch
lsinventory command.

Verifying Your Installation After Applying a Patch
After you apply one or more patches successfully, use the WebLogic
Administration Console, Fusion Middleware Control, and your
organization’s application testing to verify that your system is currently
running successfully.

1.3.1 Summary of the Steps For Using OPatch in a Fusion Middleware Environment
Applying a patch with OPatch involves a series of steps that must be performed to
ensure successful patching.

The following table summarizes the typical steps required to patch your existing
Fusion Middleware environment using OPatch.

Table 1-2    Using OPatch with Oracle Fusion Middleware

Task Description Documentation

Acquire patches
required for your
installation

Log in, search for, and download the patches
required for your specific installation.

Obtaining Patches Required for Your
Installation

Review the
README.txt file for
the patch.

Each patch archive includes a README file
that contains important information and
instructions that must be followed prior to
applying your patch. It is important to
review the README file because it provides
any unique steps or other information
specific to the patch.

The README.txt file that is packaged
within the patch archive

Using OPatch to Patch Oracle Fusion Middleware
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Table 1-2    (Cont.) Using OPatch with Oracle Fusion Middleware

Task Description Documentation

Check for patch
prerequisites.

The OPatch apply -report command will
identify that the prerequisites for the patch
have been met.

Verifying the Prerequisites for a Patch

Apply the patch. After you determine the Oracle home to
which you need to apply the patch, and you
have read the README file, then you should
apply the patch with the opatch apply
command.

Examples of Applying and Rolling Back
Patches Using OPatch

Verify the patch was
applied to the Oracle
home successfully.

The OPatch lsinventory command will show
what patches have been applied to the
Oracle home. Use this command to verify the
application of the patch.

Using the OPatch lsinventory
Command to Verify the Patches
Applied to an Oracle Home

Verify that your
software runs properly
after you apply the
patch.

After the patching is complete and your
servers are restarted, you should check your
product software to verify that the issue has
been resolved.

Verifying Your Installation After
Applying a Patch

Troubleshoot the
application of a patch.

If there are problems applying a patch, your
first troubleshooting task is to review the log
file for the OPatch session.

Troubleshooting a Patch by Viewing the
OPatch Log File

Roll back the
application of a patch.

If for some reason the result is not
satisfactory, you can use the opatch
rollback command to remove the patch
from the Oracle home.

If additional assistance is required, go to My
Oracle Support (formerly OracleMetaLink).

Rolling Back a Patch You Have Applied

See Also:

Using OPatch to Patch Oracle Fusion Middleware
Use OPatch to perform the necessary steps for applying a patch to an
Oracle home.

1.3.2 Common OPatch Commands When Patching an Oracle Fusion Middleware Oracle
Home

OPatch provides several commands that you can use to apply a patch, roll back a
patch, and verify the application of patch in an Oracle home. You can use OPatch to
apply and roll back a single patch or apply and roll back multiple patches.

Table 1-3    Common OPatch Commands Used When Patching an Oracle Fusion Middleware
Environment

Using OPatch to Patch Oracle Fusion Middleware
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Table 1-3    (Cont.) Common OPatch Commands Used When Patching an Oracle Fusion Middleware
Environment

Command Description Example

opatch apply This command applies an interim patch to an
Oracle home from the current directory. The
ORACLE_HOME environment variable
must be set to the Oracle home to be
patched.

Verifying the Prerequisites for a Patch

Applying a Single Patch Using the
Apply Command

opatch napply This command applies multiple patches. Applying Multiple Patches Using the
OPatch napply Command

opatch lsinventory This command lists the inventory for a
particular Oracle home, or displays all
installations that can be found. This
command does not have any required
options.

Using the OPatch lsinventory
Command to Verify the Patches
Applied to an Oracle Home

opatch rollback This command removes an existing one-off
patch from the appropriate Oracle home
directory indicated by the reference ID.

Rolling Back a Patch You Have Applied

opatch nrollback This command rolls back multiple interim
patches at the same time.

Rolling Back Multiple Patches You Have
Applied

See Also:

Using OPatch to Patch Oracle Fusion Middleware
Use OPatch to perform the necessary steps for applying a patch to an
Oracle home.

1.3.3 Examples of Applying and Rolling Back Patches Using OPatch
After you obtain the patches required for your installation, use the appropriate OPatch
commands to verify any patch prerequisites, apply a patch to an Oracle home, and if
necessary, roll back the application of a patch.

The following topics provide some examples of using OPatch to patch an Oracle
Fusion Middleware installation:

Using OPatch to Patch Oracle Fusion Middleware
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See Also:

Using OPatch to Patch Oracle Fusion Middleware
Use OPatch to perform the necessary steps for applying a patch to an
Oracle home.

Verifying the Prerequisites for a Patch
To verify that a patch can be applied to a specific Oracle home, use the —
report argument to the opatch apply command.

Applying a Single Patch Using the Apply Command
To apply a single patch to an Oracle Fusion Middleware Oracle home,
use the opatch apply command.

Applying Multiple Patches Using the OPatch napply Command
To apply multiple patches to an Oracle Fusion Middleware Oracle home,
use the opatch napply command.

Rolling Back a Patch You Have Applied
To roll back a patch that was applied to an Oracle Fusion Middleware
Oracle home, use the opatch rollback command.

Rolling Back Multiple Patches You Have Applied
To roll back multiple patches that were previously applied to an Oracle
Fusion Middleware Oracle home, use the opatch nrollback
command.

1.3.3.1 Verifying the Prerequisites for a Patch
To verify that a patch can be applied to a specific Oracle home, use the —report
argument to the opatch apply command.

For example:

opatch apply <path_to_patch_directory> -report

This command displays the actions that will be taken by the patch, but does not
actually apply the patch. As a result, it allows you to verify that the prerequisites for
the patch have been met.

See Also:

Examples of Applying and Rolling Back Patches Using OPatch
After you obtain the patches required for your installation, use the
appropriate OPatch commands to verify any patch prerequisites, apply a
patch to an Oracle home, and if necessary, roll back the application of a
patch.

1.3.3.2 Applying a Single Patch Using the Apply Command
To apply a single patch to an Oracle Fusion Middleware Oracle home, use the opatch
apply command.

Example 1-1 shows how to use the opatch apply command to apply a patch to an
Oracle Fusion Middleware Oracle home.

This example assumes that:

• The patch you have downloaded has been saved to a directory that is named for
the patch number in My Oracle Support. In this case, the patch number is 15941858.

Using OPatch to Patch Oracle Fusion Middleware
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• The user changes directory to the patch directory and then runs the OPatch apply
command. Alternatively, you can run the OPatch command from the
ORACLE_HOME/OPatch directory and include the location of the patch as an
argument to the command. For example:

opatch apply /opt/patches/15941858/

• The OPatch directory is already included in the PATH variable on the host
computer.

Example 1-1    Using the OPatch apply Command to Apply a Patch to an Oracle
Fusion Middleware Oracle Home

> cd /opt/patches/15941858
> opatch apply
Oracle Interim Patch Installer version 13.3.0.0.0
Copyright (c) 2013, Oracle Corporation.  All rights reserved.

Oracle Home       : /opt/Oracle/products/fmw12c
Central Inventory : /opt/Oracle/oraInventory
   from           : /var/opt/Oracle/oraInst.loc
OPatch version    : 13.3.0.0.0
OUI version       : 13.3.0.0.0
Log file location : /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
15941858_Jun_10_2013_12_35_24/apply2013-06-10_12-35-15PM_1.log

OPatch detects the Middleware Home as "/opt/Oracle/products/fmw12c"

Applying interim patch '15941858' to OH '/opt/Oracle/products/fmw12c'
Verifying environment and performing prerequisite checks...
All checks passed.

Please shutdown Oracle instances running out of this ORACLE_HOME on the local system.
(Oracle Home = '/opt/Oracle/products/fmw12c')

Is the local system ready for patching? [y|n] y
User Responded with: Y
Backing up files...

Patching component oracle.wls.core.app.server, 12.2.1.0.0...

Verifying the update...
Patch 15941858 successfully applied
Log file location: /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
15941858_Jun_10_2013_12_35_24/apply2013-06-10_12-35-15PM_1.log

--------------------------------------------------------------------------------

There are no Interim patches installed in this Oracle Home.

--------------------------------------------------------------------------------

OPatch succeeded.

See Also:

Examples of Applying and Rolling Back Patches Using OPatch
After you obtain the patches required for your installation, use the
appropriate OPatch commands to verify any patch prerequisites, apply a

Using OPatch to Patch Oracle Fusion Middleware
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patch to an Oracle home, and if necessary, roll back the application of a
patch.

1.3.3.3 Applying Multiple Patches Using the OPatch napply Command
To apply multiple patches to an Oracle Fusion Middleware Oracle home, use the
opatch napply command.

Example 1-2 shows how to use the opatch napply command to apply multiple
patches to an Oracle Fusion Middleware Oracle home.

This example assumes that the patches you have downloaded have been saved to a
staging directory, such as:

/opt/patches

It also assumes you have changed directory to the staging directory and the staging
directory contains a directory for each patch. For example:

/opt/patches/15941858
/opt/patches/15955138

Example 1-2    Using the OPatch napply Command to Apply Multiple Patches to an
Oracle Fusion Middleware Oracle Home

> /opt/Oracle/products/fmw12c/OPatch/opatch napply -id 15941858,15955138
Oracle Interim Patch Installer version 13.3.0.0.0
Copyright (c) 2013, Oracle Corporation.  All rights reserved.

Oracle Home       : /opt/Oracle/products/fmw12c
Central Inventory : /opt/Oracle/oraInventory
   from           : /var/opt/Oracle/oraInst.loc
OPatch version    : 13.3.0.0.0
OUI version       : 13.3.0.0.0
Log file location : /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
opatch2013-06-11_07-36-40AM_1.log

OPatch detects the Middleware Home as "/opt/Oracle/products/fmw12c"

Verifying environment and performing prerequisite checks...
OPatch continues with these patches:   15941858  15955138  

Do you want to proceed? [y|n]
y
User Responded with: Y
All checks passed.

Please shutdown Oracle instances running out of this ORACLE_HOME on the local system.
(Oracle Home = '/opt/Oracle/products/fmw12c')

Is the local system ready for patching? [y|n]
y
User Responded with: Y
Backing up files...
Applying interim patch '15941858' to OH '/opt/Oracle/products/fmw12c'

Patching component oracle.wls.core.app.server, 12.2.1.0.0...

Verifying the update...
Applying interim patch '15955138' to OH '/opt/Oracle/products/fmw12c'

Patching component oracle.wls.core.app.server, 12.2.1.0.0...
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Verifying the update...
Patches 15941858,15955138 successfully applied.
Log file location: /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
opatch2013-06-11_07-36-40AM_1.log

OPatch succeeded.

See Also:

Examples of Applying and Rolling Back Patches Using OPatch
After you obtain the patches required for your installation, use the
appropriate OPatch commands to verify any patch prerequisites, apply a
patch to an Oracle home, and if necessary, roll back the application of a
patch.

1.3.3.4 Rolling Back a Patch You Have Applied
To roll back a patch that was applied to an Oracle Fusion Middleware Oracle home,
use the opatch rollback command.

Example 1-3 shows how to use the opatch rollback command to roll back a patch
that was applied to an Oracle Fusion Middleware Oracle home.

This example assumes that the OPatch directory is already included in the PATH
variable on the host computer.

Example 1-3    Using the OPatch rollback Command to Roll Back a Patch

> opatch rollback -id 15941858
Oracle Interim Patch Installer version 13.3.0.0.0
Copyright (c) 2013, Oracle Corporation.  All rights reserved.

Oracle Home       : /opt/Oracle/products/fmw12c
Central Inventory : /opt/Oracle/oraInventory
   from           : /var/opt/Oracle/oraInst.loc
OPatch version    : 13.3.0.0.0
OUI version       : 13.3.0.0.0
Log file location : /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
15941858_Jun_10_2013_13_12_20/rollback2013-06-10_13-12-10PM_1.log

OPatch detects the Middleware Home as "/opt/Oracle/products/fmw12c"

RollbackSession rolling back interim patch '15941858' from OH '/opt/Oracle/products/
fmw12c'

Please shutdown Oracle instances running out of this ORACLE_HOME on the local system.
(Oracle Home = '/opt/Oracle/products/fmw12c')

Is the local system ready for patching? [y|n]
y
User Responded with: Y

Patching component oracle.wls.core.app.server, 12.2.1.0.0...
RollbackSession removing interim patch '15941858' from inventory
Log file location: /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
15941858_Jun_10_2013_13_12_20/rollback2013-06-10_13-12-10PM_1.log

OPatch succeeded.
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See Also:

Examples of Applying and Rolling Back Patches Using OPatch
After you obtain the patches required for your installation, use the
appropriate OPatch commands to verify any patch prerequisites, apply a
patch to an Oracle home, and if necessary, roll back the application of a
patch.

1.3.3.5 Rolling Back Multiple Patches You Have Applied
To roll back multiple patches that were previously applied to an Oracle Fusion
Middleware Oracle home, use the opatch nrollback command.

Example 1-4 shows how to use the opatch nrollback command to roll back
multiple patches that were previously applied to an Oracle Fusion Middleware Oracle
home.

This example assumes that the patches you applied were patch numbers 15941858 and
15955138.

Example 1-4    Using the OPatch nrollback Command to Roll Back Multiple Patches

> /opt/Oracle/products/fmw12c/OPatch/opatch nrollback -id 15941858,15955138
Oracle Interim Patch Installer version 13.3.0.0.0Copyright (c) 2013, Oracle 
Corporation.  All rights reserved.

Oracle Home       : /opt/Oracle/products/fmw12c
Central Inventory : /opt/Oracle/oraInventory
   from           : /var/opt/Oracle/oraInst.loc
OPatch version    : 13.3.0.0.0
OUI version       : 13.3.0.0.0
Log file location : /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
opatch2013-06-10_14-24-54PM_1.log

OPatch detects the Middleware Home as "/opt/Oracle/products/fmw12c"

Patches will be rolled back in the following order: 
   15941858   15955138
The following patch(es) will be rolled back: 15941858  15955138  

Please shutdown Oracle instances running out of this ORACLE_HOME on the local system.
(Oracle Home = '/opt/Oracle/products/fmw12c')

Is the local system ready for patching? [y|n]
y
User Responded with: Y

Rolling back patch 15941858...

RollbackSession rolling back interim patch '15941858' from OH '/opt/Oracle/products/
fmw12c'

Patching component oracle.wls.core.app.server, 12.2.1.0.0...
RollbackSession removing interim patch '15941858' from inventory

Rolling back patch 15955138...

RollbackSession rolling back interim patch '15955138' from OH '/opt/Oracle/products/
fmw12c'

Patching component oracle.wls.core.app.server, 12.2.1.0.0...
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RollbackSession removing interim patch '15955138' from inventory
Log file location: /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
opatch2013-06-10_14-24-54PM_1.log

OPatch succeeded.

See Also:

Examples of Applying and Rolling Back Patches Using OPatch
After you obtain the patches required for your installation, use the
appropriate OPatch commands to verify any patch prerequisites, apply a
patch to an Oracle home, and if necessary, roll back the application of a
patch.

1.3.4 Troubleshooting a Patch by Viewing the OPatch Log File
To understand how a patch is applied and to troubleshoot any problems with the
application of a patch, you should review the log file for the OPatch session.

The log file location is usually saved to the following directory or a subdirectory
within this location:

ORACLE_HOME/cfgtoollogs/opatch/

Subdirectories within this location are identified by the patch number or by the
command you ran (such as lsinv).

The file name for each log file identifies the date and time it was executed. For
example:

opatch2013-06-10_14-24-54PM_1.log

You can also locate the log file by viewing the output of the opatch command. The log
file name and location is included in the output of the command. For example:

Log file location: /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
opatch2013-06-10_14-24-54PM_1.log

See Also:

Using OPatch to Patch Oracle Fusion Middleware
Use OPatch to perform the necessary steps for applying a patch to an
Oracle home.

1.3.5 Using the OPatch lsinventory Command to Verify the Patches Applied to an
Oracle Home

To verify what patches have been applied to an Oracle home, or to find out additional
information about the Oracle home, use the opatch lsinventory command.

The following example shows sample output of the lsinventory command, which
indicates that a specific interim patch has been applied.

Example 1-5    Running the opatch lsinventory Command to Obtain the Oracle Home
Information

> opatch lsinventory
Oracle Interim Patch Installer version 13.3.0.0.0
Copyright (c) 2013, Oracle Corporation.  All rights reserved.
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Oracle Home       : /opt/Oracle/products/fmw12c
Central Inventory : /opt/Oracle/oraInventory
   from           : /var/opt/Oracle/oraInst.loc
OPatch version    : 13.3.0.0.0
OUI version       : 13.3.0.0.0
Log file location : /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
opatch2013-06-10_12-32-37PM_1.log

OPatch detects the Middleware Home as "/opt/Oracle/products/fmw12c"

Lsinventory Output file location :
/opt/Oracle/products/fmw12c/cfgtoollogs/opatch/lsinv/
lsinventory2013-06-10_12-32-37PM.txt

--------------------------------------------------------------------------------

Interim patches (1) :

Patch  15941858     : applied on Mon Jun 10 12:39:07 PDT 2013
Unique Patch ID:  150220
Patch description:  "TEST PATCH FOR WLS 12.2.1.0 - JAVA CLASSES PATCH"
   Created on 17 May 2013, 11:54:20 hrs PST8PDT
   Bugs fixed:
     783169, 15941850

--------------------------------------------------------------------------------

OPatch succeeded.

See Also:

Using OPatch to Patch Oracle Fusion Middleware
Use OPatch to perform the necessary steps for applying a patch to an
Oracle home.

1.3.6 Verifying Your Installation After Applying a Patch
After you apply one or more patches successfully, use the WebLogic Administration
Console, Fusion Middleware Control, and your organization’s application testing to
verify that your system is currently running successfully.

To verify your installations in an Oracle Fusion Middleware 12c environment:

1. Start all the servers in all the domains associated with the Oracle home you just
patched.

2. Open the WebLogic Server Administration Console for each domain to verify the
Administration Server and to view the status of the components in the domain.

• Also, in any Oracle Fusion Middleware domain (where the Oracle Fusion
Middleware Infrastructure is installed), open the Oracle Enterprise Manager
Fusion Middleware Control console to view the status of the components in the
domain.

From either console, you can verify that the servers and applications are up and
running correctly. For more information, see the following topics in Administering
Oracle Fusion Middleware:

• Starting and Stopping Oracle Fusion Middleware
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• Overview of Oracle Fusion Middleware Administration Tools

If the software does not work as expected, follow the roll back instructions in Rolling
Back a Patch You Have Applied.

See Also:

Using OPatch to Patch Oracle Fusion Middleware
Use OPatch to perform the necessary steps for applying a patch to an
Oracle home.
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2
Patching Your Environment Using

OPatchAuto

OPatchAuto is installed with the OPatch utility as a part of your installation.
OPatchAuto provides several commands that you can use to automate the application
and roll back of a patch in a single host or multi-host environment.

For more information about patching with OPatchAuto, see the following topics:

See Also:

Preparing to Use OPatchAuto
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatchAuto, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the environment.

Using OPatchAuto to Patch Oracle Fusion Middleware
Use OPatchAuto to automate the necessary steps for applying a patch on
a single host or multi-host environment.

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

Patching Your Environment Using OPatch

2.1 Preparing to Use OPatchAuto
To ensure successful patching, there are several prerequisites you should complete to
prepare your environment for running OPatchAuto, such as obtaining the latest
version of OPatch, obtaining required patches from My Oracle Support, and backing
up the environment.

For more information on preparing your environment, see the following topics:

See Also:

Patching Your Environment Using OPatchAuto
OPatchAuto is installed with the OPatch utility as a part of your
installation. OPatchAuto provides several commands that you can use to
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automate the application and roll back of a patch in a single host or
multi-host environment.

Locating and Obtaining the Latest Version of OPatch and OPatchAuto
Before you run OPatchAuto, find the OPatchAuto utility in the Oracle
home and verify that you have the latest version. If you have the latest
version of OPatchAuto, you have the latest version of OPatch.

Obtaining Patches Required For Your Installation
You can search for and download the latest patches for your installation
from My Oracle Support.

OPatchAuto Environment Variables for Fusion Middleware
Before you run OPatchAuto, ensure that you set the required
environment variables.

Creating a Wallet to Store Passwords
To successfully run OPatchAuto, you must provide a wallet on the
command line that contains the necessary password credentials for
connecting to the environment.

Configuring Node Manager to Support Start and Stop Operations
To ensure that OPatchAuto can properly stop and start your system
during patching, you must configure the Node Manager(s) to support
the start and stop operations.

Remote Host Patching on Windows
For patching on Windows machines, ensure that Cygwin SSH server is
installed and set up. OPatchAuto does not support other SSH servers at
this time.

Backup and Recovery Considerations for Patching
It is highly recommended that you back up the Oracle home before any
patch operation. You can back up the Oracle home using your preferred
method.

2.1.1 Locating and Obtaining the Latest Version of OPatch and OPatchAuto
Before you run OPatchAuto, find the OPatchAuto utility in the Oracle home and
verify that you have the latest version. If you have the latest version of OPatchAuto,
you have the latest version of OPatch.

For more information, see the following topics:

See Also:

Preparing to Use OPatchAuto
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatchAuto, such as
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obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the environment.

Locating and Running OPatchAuto in the Oracle Fusion Middleware Oracle
Home

You can find and run the OPatchAuto utility in the ORACLE_HOME/
OPatch directory after you install any Oracle Fusion Middleware
product.

Identifying the Version of OPatchAuto Included with Oracle Fusion Middleware
12c

Oracle Fusion Middleware 12c (12.2.1) includes OPatchAuto version
13.3.0.0.0. Use the opatchauto version command to verify that you
have this version.

2.1.1.1 Locating and Running OPatchAuto in the Oracle Fusion Middleware Oracle
Home
You can find and run the OPatchAuto utility in the ORACLE_HOME/OPatch directory
after you install any Oracle Fusion Middleware product.

To run OPatchAuto, simply run the opatchauto command in this directory.

For example, to view the list of commands available for OPatchAuto on a Unix system,
enter the following:

./opatchauto -help

See Also:

Locating and Obtaining the Latest Version of OPatch and OPatchAuto
Before you run OPatchAuto, find the OPatchAuto utility in the Oracle
home and verify that you have the latest version. If you have the latest
version of OPatchAuto, you have the latest version of OPatch.

2.1.1.2 Identifying the Version of OPatchAuto Included with Oracle Fusion
Middleware 12c
Oracle Fusion Middleware 12c (12.2.1) includes OPatchAuto version 13.3.0.0.0. Use the
opatchauto version command to verify that you have this version.

In general, there is a version of OPatch and OPatchAuto available for each version of
the Oracle Universal Installer software.

To identify the version of OPatchAuto:

1. Change directory to the following directory:

cd ORACLE_HOME/OPatch/

2. Run the following command:

./opatchauto version

For example:

./opatchauto version
Oracle OPatchAuto Version 13.3.0.0.0
Copyright (c) 2015, Oracle Corporation.  All rights reserved.

1. OPatchAuto version 13.3.0.0.0

Preparing to Use OPatchAuto
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If you have the latest version of OPatchAuto, you have the latest version of OPatch. If
you do not have the latest version, OPatch can be downloaded using patch 6880880.
You should always use the latest download designated for your installation.  For
Oracle Fusion Middleware 12c (12.2.1), select OUI NextGen 13.3 for the version and
platform, and then click Download to download OUI NextGen OPatch 13.3.

See Also:

Locating and Obtaining the Latest Version of OPatch and OPatchAuto
Before you run OPatchAuto, find the OPatchAuto utility in the Oracle
home and verify that you have the latest version. If you have the latest
version of OPatchAuto, you have the latest version of OPatch.

Identifying the Version of OPatch Included with Oracle Fusion Middleware 12c
Oracle Fusion Middleware 12c (12.2.1) includes OPatch version
13.3.0.0.0. This version includes new features and capabilities that are
designed to improve the experience of patching an Oracle Fusion
Middleware 12c Oracle home.

2.1.2 Obtaining Patches Required For Your Installation
You can search for and download the latest patches for your installation from My
Oracle Support.

You can check for the latest patches available for your Oracle Fusion Middleware
product or component by registering and logging in to My Oracle Support at:

http://support.oracle.com

After you log in to My Oracle Support, click the Patches and Updates tab, which
provides various tools that allow you to quickly locate the patches most important to
your Oracle software installation.

Note:   

It is important that you review the README file that is included with each
patch. The README file includes important information about the
requirements and procedures for applying the patch.

See Also:

Preparing to Use OPatchAuto
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatchAuto, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the environment.

2.1.3 OPatchAuto Environment Variables for Fusion Middleware
Before you run OPatchAuto, ensure that you set the required environment variables.

OPatchAuto uses the following environment variables:

• The ORACLE_HOME environment variable is used to identify the Oracle home
you are planning to patch.

Preparing to Use OPatchAuto
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• The JAVA_HOME environment variable is used to identify the location of the JDK
software you will be using to patch your environment.

• The PATCH_HOME environment variable is used to identify the location of the
patch directory that contains the patches to be applied to the Oracle home.

See Also:

Preparing to Use OPatchAuto
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatchAuto, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the environment.

2.1.4 Creating a Wallet to Store Passwords
To successfully run OPatchAuto, you must provide a wallet on the command line that
contains the necessary password credentials for connecting to the environment.

The wallet should contain SSH credentials for each host in your environment, as well
as the credentials for accessing the WebLogic Administration Server. To create a
wallet, use the patchingWallet.sh tool in the ORACLE_HOME/OPatch/auto/
core/bin directory, as shown in the following example:

./patchingWallet.sh –create -walletDir wallet_location "user:adminhost:ssh" 
"user:host1:ssh" "user:host2:ssh" "adminuser:adminhost:wls"

For example:

./patchingWallet.sh –create -walletDir /tmp/samplewallet "oracle:adminhost:ssh" 
"oracle:host1:ssh" 
"oracle:host2:ssh" "weblogic:adminhost:wls"

The tool will prompt you to enter and confirm the password for each credential:

oracle:adminhost:ssh:
Confirm oracle:adminhost:ssh:
oracle:host1:ssh:
Confirm oracle:host1:ssh:
oracle:host2:ssh:
Confirm oracle:host2:ssh:
weblogic:adminhost:wls:
Confirm weblogic:adminhost:wls:

See Also:

Preparing to Use OPatchAuto
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatchAuto, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the environment.

2.1.5 Configuring Node Manager to Support Start and Stop Operations
To ensure that OPatchAuto can properly stop and start your system during patching,
you must configure the Node Manager(s) to support the start and stop operations.

To do this, set the QuitEnabled and CrashRecoveryEnabled properties in the
nodemanager.properties file as follows:

Preparing to Use OPatchAuto
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QuitEnabled=true
CrashRecoveryEnabled=false

By default, this file is created in the Node Manager home directory, where the Node
Manager home is typically DOMAIN_HOME/nodemanager.

After updating these properties, restart the Node Manager(s).

For more information about the nodemanager.properties file, see Reviewing
nodemanager.properties in Administering Node Manager for Oracle WebLogic Server

See Also:

Preparing to Use OPatchAuto
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatchAuto, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the environment.

2.1.6 Remote Host Patching on Windows
For patching on Windows machines, ensure that Cygwin SSH server is installed and
set up. OPatchAuto does not support other SSH servers at this time.

For more information, see Remote Host Execution Using SSH in the Oracle OPatch
User’s Guide for Windows and UNIX.

See Also:

Preparing to Use OPatchAuto
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatchAuto, such as
obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the environment.

2.1.7 Backup and Recovery Considerations for Patching
It is highly recommended that you back up the Oracle home before any patch
operation. You can back up the Oracle home using your preferred method.

You can use any method such as zip, cp -r, tar, and cpio to compress the Oracle
home.

If the Oracle home does not appear when you execute the opatch lsinventory -
detail command, the Oracle home might be missing from the Central Inventory, or
the Central Inventory itself could be missing or corrupted.

If the Oracle home is listed when you execute the opatch lsinventory -detail
command, but the products and components within the Oracle home are not listed,
the inventory within the Oracle home (local inventory) might be missing or corrupted.

If the local inventory is corrupted or lost for some reason, you must restore the entire
Oracle home if it was backed up. If a backup does not exist, you may have to reinstall
the software.

See Also:

Preparing to Use OPatchAuto
To ensure successful patching, there are several prerequisites you should
complete to prepare your environment for running OPatchAuto, such as
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obtaining the latest version of OPatch, obtaining required patches from
My Oracle Support, and backing up the environment.

2.2 Using OPatchAuto to Patch Oracle Fusion Middleware
Use OPatchAuto to automate the necessary steps for applying a patch on a single host
or multi-host environment.

The following topics describe how to use OPatchAuto to patch Oracle Fusion
Middleware.

See Also:

Patching Your Environment Using OPatchAuto
OPatchAuto is installed with the OPatch utility as a part of your
installation. OPatchAuto provides several commands that you can use to
automate the application and roll back of a patch in a single host or
multi-host environment.

Summary of the Steps For Using OPatchAuto in a Fusion Middleware
Environment

Applying a patch with OPatchAuto involves a series of steps that must
be performed to ensure successful patching.

Applying a Patch on a Single Host Using OPatchAuto
After you obtain the patches required for your installation, use the
opatchauto apply —analyze command to verify prerequisites, and
then use opatchauto apply —instance to apply a patch on a single
host. If needed, you can use opatchauto rollback to roll back the
application of a patch.

Applying a Patch on Multiple Hosts Using OPatchAuto
After you obtain the necessary patches, use the opatchauto apply —
analyze command to verify prerequisites, and then use opatchauto
apply —topology to apply a patch on multiple hosts. If needed, you
can use opatchauto rollback to roll back the application of a patch.

Troubleshooting a Patch by Viewing the OPatchAuto Log File
To understand how a patch is applied and to troubleshoot any problems
with the application of a patch, you should review the log file for the
OPatchAuto session.

Using the OPatch lsinventory Command to Verify the Patches Applied to an
Oracle Home

To verify what patches have been applied to an Oracle home, or to find
out additional information about the Oracle home, use the opatch
lsinventory command.

Using the listDomainPatchInventory.sh Command to Verify the Patches Applied
to a Domain

To verify what patches have been applied to a domain, use the
listDomainPatchInventory.sh command. Use this command with
the OPatch lsinventory command to verify that the patch has been
applied successfully.

Verifying Your Installation After Applying a Patch
After you apply one or more patches successfully, use the WebLogic
Administration Console, Fusion Middleware Control, and your

Using OPatchAuto to Patch Oracle Fusion Middleware
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organization’s application testing to verify that your system is currently
running successfully.

2.2.1 Summary of the Steps For Using OPatchAuto in a Fusion Middleware Environment
Applying a patch with OPatchAuto involves a series of steps that must be performed
to ensure successful patching.

The following table summarizes the typical steps required to patch your existing
Fusion Middleware environment using OPatchAuto.

Table 2-1    Using OPatchAuto with Oracle Fusion Middleware

Task Description Documentation

Acquire patches
required for your
installation

Log in, search for, and download the patches
required for your specific installation.

You do not need to worry about whether
OPatchAuto supports a particular patch
type. If OPatchAuto does not support a
particular patch type, you will be notified
when you run the tool.

Obtaining Patches Required For Your
Installation

Review the
README.txt file for
the patch.

Each patch archive includes a README file
that contains important information and
instructions that must be followed prior to
applying your patch. It is important to
review the README file because it provides
any unique steps or other information
specific to the patch.

The README.txt file that is packaged
within the patch archive

For a multi-host
environment, define
your topology
(configuration) using
Fusion Middleware
Composer.

To apply a patch on multiple hosts, you
must create a topology file using Fusion
Middleware Composer. This file contains
information about your configuration. The
topology file provides a way for OPatchAuto
to obtain information from your
environment so it can automate the
application of the patch.

Building A Topology Using Fusion
Middleware Composer

Check for patch
prerequisites.

The OPatchAuto apply -analyze
command will identify that the prerequisites
for the patch have been met.

If you are patching a single host
environment, see Verifying the
Prerequisites for Applying a Patch on a
Single Host.

If you are patching a multi-host
environment, see Verifying the
Prerequisites for Applying a Patch on
Multiple Hosts.

Apply the patch. After you determine the Oracle home to
which you need to apply the patch, and you
have read the README file, then you should
apply the patch with the opatchauto
apply command.

If you are patching a single host
environment, see Applying a Patch on a
Single Host Using the Apply Command

If you are patching a multi-host
environment, see Applying a Patch on
Multiple Hosts Using the Apply
Command

Using OPatchAuto to Patch Oracle Fusion Middleware
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Table 2-1    (Cont.) Using OPatchAuto with Oracle Fusion Middleware

Task Description Documentation

Verify the patch was
applied to the Oracle
home successfully.

The OPatch lsinventory command will
show what patches have been applied to the
Oracle home. The
listDomainPatchInventory.sh
command will show the patches applied to
the domain. Use these commands together to
verify the application of the patch.

Using the OPatch lsinventory
Command to Verify the Patches
Applied to an Oracle Home

Using the listDomainPatchInventory.sh
Command to Verify the Patches
Applied to a Domain

Verify that your
software runs properly
after you apply the
patch.

After the patching is complete and your
servers are restarted, you should check your
product software to verify that the issue has
been resolved.

Verifying Your Installation After
Applying a Patch

Troubleshoot the
application of a patch.

If there are problems applying a patch, your
first troubleshooting task is to review the log
file for the OPatchAuto session.

Troubleshooting a Patch by Viewing the
OPatchAuto Log File

Roll back the
application of a patch.

If for some reason the result is not
satisfactory, you can use the opatchauto
rollback command to remove the patch
from the Oracle home.

If additional assistance is required, go to My
Oracle Support (formerly OracleMetaLink).

For a single host environment, see 
Rolling Back a Patch You Have Applied
on a Single Host.

For a multi-host environment, see 
Rolling Back a Patch You Have Applied
on Multiple Hosts.

See Also:

Using OPatchAuto to Patch Oracle Fusion Middleware
Use OPatchAuto to automate the necessary steps for applying a patch on
a single host or multi-host environment.

2.2.2 Applying a Patch on a Single Host Using OPatchAuto
After you obtain the patches required for your installation, use the opatchauto
apply —analyze command to verify prerequisites, and then use opatchauto
apply —instance to apply a patch on a single host. If needed, you can use
opatchauto rollback to roll back the application of a patch.

Patching a single host environment with OPatchAuto involves the following tasks:

See Also:

Using OPatchAuto to Patch Oracle Fusion Middleware
Use OPatchAuto to automate the necessary steps for applying a patch on
a single host or multi-host environment.

Verifying the Prerequisites for Applying a Patch on a Single Host
To verify that a patch can be applied on a single host, use the —analyze
argument to the OPatchAuto apply command. For single host patching,
you must also provide the domain location using the —instance
argument.

Applying a Patch on a Single Host Using the Apply Command
To apply a patch on a single host, use the opatchauto apply
command. This is the same command as opatchauto apply —
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analyze, except you remove the —analyze argument when you are
ready to apply the patch.

Rolling Back a Patch You Have Applied on a Single Host
If you apply a patch and the results are not satisfactory, use the
opatchauto rollback command to roll back the application of the
patch. This is the same command as opatchauto rollback –
analyze, except you remove the -analyze argument when you are
ready to roll back the patch.

2.2.2.1 Verifying the Prerequisites for Applying a Patch on a Single Host
To verify that a patch can be applied on a single host, use the —analyze argument to
the OPatchAuto apply command. For single host patching, you must also provide the
domain location using the —instance argument.

The following command shows how to verify the prerequisites for applying a patch on
a single host:

opatchauto apply PATCH_HOME -analyze -instance DOMAIN_HOME -wallet wallet_location -
walletPassword password_ifneeded 
-wls-admin-host weblogic_adminserver_host:port

For example:

opatchauto apply /home/oracle/patches/15941858 -analyze -instance /home/oracle/
config/domains/exampledomain -wallet /tmp/samplewallet 
-wls-admin-host examplehost.exampledomain.com:7001

If you want to apply multiple patches in one session, use the –phBaseDir option.

This command analyzes and displays the actions that will be taken by the patch, but
does not actually apply the patch. As a result, it allows you to verify that the
prerequisites for the patch have been met.

If any prerequisite checks fail, refer to the output and log file to fix the issues before
continuing. For example, a common failure is the detection of patch conflicts. If any
patch conflicts occur, follow the instructions in the log file for how to obtain a merge
patch from Oracle Support.

See Also:

Applying a Patch on a Single Host Using OPatchAuto
After you obtain the patches required for your installation, use the
opatchauto apply —analyze command to verify prerequisites, and
then use opatchauto apply —instance to apply a patch on a single
host. If needed, you can use opatchauto rollback to roll back the
application of a patch.

2.2.2.2 Applying a Patch on a Single Host Using the Apply Command
To apply a patch on a single host, use the opatchauto apply command. This is the
same command as opatchauto apply —analyze, except you remove the —
analyze argument when you are ready to apply the patch.

This topic shows an example of using the opatchauto apply command to apply a
patch to an Oracle Fusion Middleware environment on a single host.

This example assumes that:
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• The patch you have downloaded has been saved to a directory that is named for
the patch number in My Oracle Support. In this case, the patch number is 15941858.

• The user runs the OPatchAuto command from the ORACLE_HOME/OPatch
directory and includes the location of the patch (PATCH_HOME) as an argument
to the command.

Note:   

When you run the opatchauto apply command, make a note of the session
id (for example, EKZR) in the command output. This will simplify the rollback
process if you decide to roll back the patch later.

opatchauto apply PATCH_HOME -instance DOMAIN_HOME -wallet wallet_location -
walletPassword password_ifneeded -wls-admin-host weblogic_adminserver_host:port

For example:

opatchauto apply /home/oracle/patches/15941858 -instance /home/oracle/config/domains/
exampledomain -wallet /tmp/samplewallet 
-walletPassword password -wls-admin-host examplehost.exampledomain.com:7001

See Also:

Applying a Patch on a Single Host Using OPatchAuto
After you obtain the patches required for your installation, use the
opatchauto apply —analyze command to verify prerequisites, and
then use opatchauto apply —instance to apply a patch on a single
host. If needed, you can use opatchauto rollback to roll back the
application of a patch.

2.2.2.3 Rolling Back a Patch You Have Applied on a Single Host
If you apply a patch and the results are not satisfactory, use the opatchauto
rollback command to roll back the application of the patch. This is the same
command as opatchauto rollback –analyze, except you remove the -analyze
argument when you are ready to roll back the patch.

This topic shows an example of using the opatchauto rollback command to roll
back a patch that was applied to an Oracle Fusion Middleware environment on a
single host.

To do a roll back, you follow the same process for when you applied the patch. That is,
you first do a test run of the opatchauto rollback command:

Note:   

You can simplify the command if you provide the session id (for example,
EKZR) that was used to apply the patch. Then, OPatchAuto can derive all the
necessary command line parameters.

opatchauto rollback –session session_id -analyze –wallet wallet_location -
walletPassword password_ifneeded -wls-admin-host weblogic_adminserver_host:port 

For example:
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opatchauto rollback –session EKZR -analyze –wallet /tmp/samplewallet -walletPassword 
password -wls-admin-host examplehost.exampledomain.com:7001

When the test run successfully passes, perform the actual roll back of the patch:

opatchauto rollback –session session_id –wallet wallet_location -walletPassword 
password_ifneeded -wls-admin-host weblogic_adminserver_host:port

For example:

opatchauto rollback –session EKZR –wallet /tmp/samplewallet -walletPassword password 
-wls-admin-host examplehost.exampledomain.com:7001

Alternatively, if you do not remember your session id when you applied the pach, you
can roll back the patch by pointing OPatchAuto to a copy of the unzipped patch as
follows:

opatchauto rollback unzipped_patch_location -instance DOMAIN_HOME –wallet 
wallet_location -walletPassword password_ifneeded 
-wls-admin-host weblogic_adminserver_host:port

See Also:

Applying a Patch on a Single Host Using OPatchAuto
After you obtain the patches required for your installation, use the
opatchauto apply —analyze command to verify prerequisites, and
then use opatchauto apply —instance to apply a patch on a single
host. If needed, you can use opatchauto rollback to roll back the
application of a patch.

2.2.3 Applying a Patch on Multiple Hosts Using OPatchAuto
After you obtain the necessary patches, use the opatchauto apply —analyze
command to verify prerequisites, and then use opatchauto apply —topology to
apply a patch on multiple hosts. If needed, you can use opatchauto rollback to
roll back the application of a patch.

Note:   

Before applying a patch on multiple hosts, ensure that you have created a
topology file using Fusion Middleware Composer. You must supply this file
on the command line using the -topology option when you run
OPatchAuto. OPatchAuto uses this file to obtain information from your
environment to identify the configuration that you want to patch. For an
example on how to create a topology file, see Building A Topology Using
Fusion Middleware Composer.

Patching a multi-host environment with OPatchAuto involves the following tasks:

See Also:

Using OPatchAuto to Patch Oracle Fusion Middleware
Use OPatchAuto to automate the necessary steps for applying a patch on
a single host or multi-host environment.

Verifying the Prerequisites for Applying a Patch on Multiple Hosts
To ensure successful patching, use the opatchauto apply —analyze
command to check for any prerequisites. For multi-host patching, you

Using OPatchAuto to Patch Oracle Fusion Middleware

2-12  Patching with OPatch



must provide the Fusion Middleware Composer topology file using the
-topology argument.

Applying a Patch on Multiple Hosts Using the Apply Command
To apply a patch on multiple hosts, use the opatchauto apply
command. This is the same command as opatchauto apply —
analyze, except you remove the -analyze argument when you are
ready to apply the patch.

Rolling Back a Patch You Have Applied on Multiple Hosts
If you apply a patch and the results are not satisfactory, use the
opatchauto rollback command to roll back the application of a
patch. This is the same command as opatchauto rollback –
analyze, except you remove the -analyze argument when you are
ready to roll back the patch.

2.2.3.1 Verifying the Prerequisites for Applying a Patch on Multiple Hosts
To ensure successful patching, use the opatchauto apply —analyze command to
check for any prerequisites. For multi-host patching, you must provide the Fusion
Middleware Composer topology file using the -topology argument.

To verify that a patch can be applied to a specific Oracle home (ORACLE_HOME) and
domain location (DOMAIN_HOME) on multiple hosts, use the —analyze argument
to the OPatchAuto apply command.

opatchauto apply PATCH_HOME -analyze -topology fmwcomposer_topology_file -wallet 
wallet_location -walletPassword password_ifneeded 

For example:

opatchauto apply /home/oracle/patches/15941858 -analyze -topology /tmp/topology.xml -
wallet /tmp/samplewallet -walletPassword password 

If you want to apply multiple patches in one session, use the –phBaseDir option.

This command displays the actions that will be taken by the patch, but does not
actually apply the patch. As a result, it allows you to verify that the prerequisites for
the patch have been met.

If any prerequisite checks fail, refer to the command output and log file to fix any
issues before continuing. For example, a common failure is the detection of patch
conflicts. If any patch conflicts occur, follow the instructions in the log file for how to
obtain a merge patch from Oracle Support.

See Also:

Applying a Patch on Multiple Hosts Using OPatchAuto
After you obtain the necessary patches, use the opatchauto apply —
analyze command to verify prerequisites, and then use opatchauto
apply —topology to apply a patch on multiple hosts. If needed, you
can use opatchauto rollback to roll back the application of a patch.

2.2.3.2 Applying a Patch on Multiple Hosts Using the Apply Command
To apply a patch on multiple hosts, use the opatchauto apply command. This is
the same command as opatchauto apply —analyze, except you remove the -
analyze argument when you are ready to apply the patch.

This topic shows an example of using the opatchauto apply command to apply a
patch to an Oracle Fusion Middleware environment on multiple hosts.
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This example assumes that:

• The patch you have downloaded has been saved to a directory that is named for
the patch number in My Oracle Support. In this case, the patch number is 15941858.

• The user runs the OPatchAuto command from the ORACLE_HOME/OPatch
directory and includes the location of the patch (PATCH_HOME) as an argument
to the command.

Note:   

When you run the opatchauto apply command, make a note of the session
id (for example, EKZR) in the command output. This will simplify the rollback
process if you decide to roll back the patch later.

opatchauto apply PATCH_HOME -topology fmwcomposer_topology_file -wallet 
wallet_location -walletPassword password_ifneeded 

For example:

opatchauto apply /home/oracle/patches/15941858 -topology /tmp/topology.xml -
wallet /tmp/samplewallet -walletPassword password 

See Also:

Applying a Patch on Multiple Hosts Using OPatchAuto
After you obtain the necessary patches, use the opatchauto apply —
analyze command to verify prerequisites, and then use opatchauto
apply —topology to apply a patch on multiple hosts. If needed, you
can use opatchauto rollback to roll back the application of a patch.

2.2.3.3 Rolling Back a Patch You Have Applied on Multiple Hosts
If you apply a patch and the results are not satisfactory, use the opatchauto
rollback command to roll back the application of a patch. This is the same command
as opatchauto rollback –analyze, except you remove the -analyze argument
when you are ready to roll back the patch.

This topic shows an example of using the opatchauto rollback command to roll
back a patch that was applied to an Oracle Fusion Middleware environment on
multiple hosts.

To do a roll back, you follow the same process for when you applied the patch. That is,
you first do a test run of the opatchauto rollback command:

Note:   

You can simplify the command if you provide the session id (for example,
EKZR) that was used to apply the patch. Then, OPatchAuto can derive all the
necessary command line parameters.

opatchauto rollback –session session_id -analyze –wallet wallet_location -
walletPassword password_ifneeded 

For example:

Using OPatchAuto to Patch Oracle Fusion Middleware

2-14  Patching with OPatch



opatchauto rollback –session EKZR -analyze –wallet /tmp/samplewallet -walletPassword 
password

When the test run successfully passes, perform the actual roll back of the patch:

opatchauto rollback –session session_id –wallet wallet_location -walletPassword 
password_ifneeded 

For example:

opatchauto rollback –session EKZR –wallet /tmp/samplewallet -walletPassword password

Alternatively, if you do not remember your session id when you applied the pach, you
can roll back the patch by pointing OPatchAuto to a copy of the unzipped patch as
follows:

opatchauto rollback unzipped_patch_location -topology fmwcomposer_topology_file –
wallet wallet_location -walletPassword password_ifneeded  

See Also:

Applying a Patch on Multiple Hosts Using OPatchAuto
After you obtain the necessary patches, use the opatchauto apply —
analyze command to verify prerequisites, and then use opatchauto
apply —topology to apply a patch on multiple hosts. If needed, you
can use opatchauto rollback to roll back the application of a patch.

2.2.4 Troubleshooting a Patch by Viewing the OPatchAuto Log File
To understand how a patch is applied and to troubleshoot any problems with the
application of a patch, you should review the log file for the OPatchAuto session.

The log file location is usually saved to the following directory or a subdirectory
within this location:

ORACLE_HOME/cfgtoollogs/opatchauto/

Subdirectories within this location are identified by the patch number or by the
command you ran.

The file name for each log file identifies the date and time it was executed. For
example:

opatchauto2015-09-28_11-47-13AM.log

You can also locate the log file by viewing the output of the opatchauto command.
The log file name and location is included in the output of the command. For example:

Session log file is /home/Oracle/products/fmw12c/cfgtoollogs/opatchauto/
opatchauto2015-09-28_11-47-13AM.log
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See Also:

Using OPatchAuto to Patch Oracle Fusion Middleware
Use OPatchAuto to automate the necessary steps for applying a patch on
a single host or multi-host environment.

2.2.5 Using the OPatch lsinventory Command to Verify the Patches Applied to an
Oracle Home

To verify what patches have been applied to an Oracle home, or to find out additional
information about the Oracle home, use the opatch lsinventory command.

The following example shows sample output of the lsinventory command, which
indicates that a specific interim patch has been applied.

Example 2-1    Running the opatch lsinventory Command to Obtain the Oracle Home
Information

> opatch lsinventory
Oracle Interim Patch Installer version 13.3.0.0.0
Copyright (c) 2013, Oracle Corporation.  All rights reserved.

Oracle Home       : /opt/Oracle/products/fmw12c
Central Inventory : /opt/Oracle/oraInventory
   from           : /var/opt/Oracle/oraInst.loc
OPatch version    : 13.3.0.0.0
OUI version       : 13.3.0.0.0
Log file location : /opt/Oracle/products/fmw12c/cfgtoollogs/opatch/
opatch2013-06-10_12-32-37PM_1.log

OPatch detects the Middleware Home as "/opt/Oracle/products/fmw12c"

Lsinventory Output file location :
/opt/Oracle/products/fmw12c/cfgtoollogs/opatch/lsinv/
lsinventory2013-06-10_12-32-37PM.txt

--------------------------------------------------------------------------------

Interim patches (1) :

Patch  15941858     : applied on Mon Jun 10 12:39:07 PDT 2013
Unique Patch ID:  150220
Patch description:  "TEST PATCH FOR WLS 12.2.1.0 - JAVA CLASSES PATCH"
   Created on 17 May 2013, 11:54:20 hrs PST8PDT
   Bugs fixed:
     783169, 15941850

--------------------------------------------------------------------------------

OPatch succeeded.
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See Also:

Using OPatchAuto to Patch Oracle Fusion Middleware
Use OPatchAuto to automate the necessary steps for applying a patch on
a single host or multi-host environment.

2.2.6 Using the listDomainPatchInventory.sh Command to Verify the Patches Applied to
a Domain

To verify what patches have been applied to a domain, use the
listDomainPatchInventory.sh command. Use this command with the OPatch
lsinventory command to verify that the patch has been applied successfully.

For example:

cd ORACLE_HOME/OPatch/bin
./listDomainPatchInventory.sh DOMAIN_HOME

This command indicates that a specific interim patch has been applied.

You should see the same list of patches in both the domain inventory and in the
inventory for each Oracle home. If not, re-apply the patch. When you re-apply the
patch, only the missing steps will be executed. The tasks that have already been
performed will be skipped.

See Also:

Using OPatchAuto to Patch Oracle Fusion Middleware
Use OPatchAuto to automate the necessary steps for applying a patch on
a single host or multi-host environment.

Using the OPatch lsinventory Command to Verify the Patches Applied to an
Oracle Home

To verify what patches have been applied to an Oracle home, or to find
out additional information about the Oracle home, use the opatch
lsinventory command.

2.2.7 Verifying Your Installation After Applying a Patch
After you apply one or more patches successfully, use the WebLogic Administration
Console, Fusion Middleware Control, and your organization’s application testing to
verify that your system is currently running successfully.

To verify your installations in an Oracle Fusion Middleware 12c environment:

1. Ensure that all the servers in all the domains associated with the Oracle home you
just patched are up and running.

Note:   

If the servers were up and running before patching, it is not necessary to
manually restart the servers. OPatchAuto will restart the servers for you once
patching is complete.

2. Open the WebLogic Server Administration Console for each domain to verify the
Administration Server and to view the status of the components in the domain.
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• Also, in any Oracle Fusion Middleware domain (where the Oracle Fusion
Middleware Infrastructure is installed), open the Oracle Enterprise Manager
Fusion Middleware Control console to view the status of the components in the
domain.

From either console, you can verify that the servers and applications are up and
running correctly. For more information, see the following topics in Administering
Oracle Fusion Middleware:

• Starting and Stopping Oracle Fusion Middleware

• Overview of Oracle Fusion Middleware Administration Tools

If the software does not work as expected, follow the rollback instructions to roll back
the application of the patch.

See Also:

Using OPatchAuto to Patch Oracle Fusion Middleware
Use OPatchAuto to automate the necessary steps for applying a patch on
a single host or multi-host environment.

Rolling Back a Patch You Have Applied on a Single Host
If you apply a patch and the results are not satisfactory, use the
opatchauto rollback command to roll back the application of the
patch. This is the same command as opatchauto rollback –
analyze, except you remove the -analyze argument when you are
ready to roll back the patch.

Rolling Back a Patch You Have Applied on Multiple Hosts
If you apply a patch and the results are not satisfactory, use the
opatchauto rollback command to roll back the application of a
patch. This is the same command as opatchauto rollback –
analyze, except you remove the -analyze argument when you are
ready to roll back the patch.

2.3 Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in a topology
file. Use Fusion Middleware Composer to create this file and provide information
about your environment to OPatchAuto. This file allows OPatchAuto to identify the
topology you want to patch and automatically perform the patching steps without
manual intervention.

The following topics provide an overview of how to use Fusion Middleware
Composer, as well as an example for how to build a topology file that you can provide
to OPatchAuto:

See Also:

Patching Your Environment Using OPatchAuto
OPatchAuto is installed with the OPatch utility as a part of your
installation. OPatchAuto provides several commands that you can use to
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automate the application and roll back of a patch in a single host or
multi-host environment.

Starting Fusion Middleware Composer
You can start and access Fusion Middleware Composer from the
ORACLE_HOME/oracle_common/bin directory.

Getting Started with Fusion Middleware Composer
Fusion Middleware Composer provides several graphical interface tools.
Use these tools to complete tasks in Fusion Middleware Composer, such
as adding and defining items in the workspace, to build a topology file.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

Creating a New Topology
To start adding and defining items in the workspace, create a new
topology file where you will save configuration information about your
environment. Every time you make changes in the workspace, make
sure to save your work to this file.

Loading a Wallet File
Credentials that are used to connect to the environment and required to
run OPatchAuto, such as the credentials for connecting to the domain’s
Administration Server, must be stored and available in a separate wallet
file. In Fusion Middleware Composer, use the Settings page to load and
edit an existing wallet file or to create a new wallet.

Adding the Hosts
Building a topology in Fusion Middleware Composer starts with
creating a host, which is a physical or virtual machine that can be
associated with an Oracle home and domain. A host is defined in the
topology by its IP address.

Adding the Oracle Home
After you create and define the hosts, add and define the Oracle home(s)
available in the environment. To define an Oracle home, you must
provide the absolute path to the Oracle home directory.

Building the WebLogic Domain
For a multi-host environment, you need to build and define a WebLogic
domain, which typically includes an Administration Server and a cluster
of Managed Servers.

Adding the Node Managers
If you have Node Managers being used in the environment, each Node
Manager has to be defined in the topology file.

Assigning Components to Hosts
After all the components in the environment have been defined, map the
components on the right side of the Fusion Middleware Composer
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workspace to the appropriate hosts on the left to finish building the
topology.

2.3.1 Starting Fusion Middleware Composer
You can start and access Fusion Middleware Composer from the ORACLE_HOME/
oracle_common/bin directory.

To start Fusion Middleware Composer:

1. Set the JAVA_HOME environment variable so it references the location of the JDK
software you will be using to run Fusion Middleware Composer.

2. Change directory to the ORACLE_HOME/oracle_common/bin directory.

For example:

cd ORACLE_HOME/oracle_common/bin

3. Launch Fusion Middleware Composer (fmw-composer.sh), as shown in the
following example:

./fmw-composer.sh

See Also:

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

Getting Started with Fusion Middleware Composer
Fusion Middleware Composer provides several graphical interface tools.
Use these tools to complete tasks in Fusion Middleware Composer, such
as adding and defining items in the workspace, to build a topology file.

2.3.2 Getting Started with Fusion Middleware Composer
Fusion Middleware Composer provides several graphical interface tools. Use these
tools to complete tasks in Fusion Middleware Composer, such as adding and defining
items in the workspace, to build a topology file.

After you start Fusion Middleware Composer, the following screen appears:
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Figure 2-1    Fusion Middleware Composer Graphical Interface

This screen shows the Fusion Middleware Composer workspace area where you will
add and define components to build your topology.

Table 2-2 describes some of the Fusion Middleware Composer graphical tools (Figure
2-2) that you can use to create a topology file.

Figure 2-2    Fusion Middleware Composer Toolbar

Table 2-2    Fusion Middleware Composer Graphical Tools

Tool Description Menu Location

Select this option to create a new topology file.

See Creating a New Topology.

File > New

Select this option to open an existing topology file. When you
select this option, a dialog box appears that you can use to identify
the location of the existing topology file that you want to open.

File > Open...

Select this option to save the topology file. File > Save

Select this option to add a new item (Host, Domain, Node
Manager, etc.) to the topology.

The items that you can add depend on the existing object that is
selected in the workspace. For example, you can add a server to a
cluster only if the cluster object is selected. For more information,
see Add and Define the Managed Servers.

Edit
The menu options available
depend on the current object
selected in the workspace.
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Table 2-2    (Cont.) Fusion Middleware Composer Graphical Tools

Tool Description Menu Location

Select this option to assign an existing item (such as an Oracle
home) to another item in the topology (such as a host).

The existing items you can assign depend on the object that is
selected in the workspace.

For example, to assign an Oracle home to a host, the host object
must be selected. For more information, see Assigning the Oracle
Home to Hosts.

Edit
The menu options available
depend on the current object
selected in the workspace.

Select this option to remove an item (such as an Oracle home) from
another item in the topology (such as a host). The item you want to
remove must be selected.

Edit
The menu options available
depend on the current object
selected in the workspace.

Select this option to delete an item from the topology. The item you
want to delete must be selected.

Edit
The menu options available
depend on the current object
selected in the workspace.

See Also:

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

Starting Fusion Middleware Composer
You can start and access Fusion Middleware Composer from the
ORACLE_HOME/oracle_common/bin directory.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.3 Example of Building a Topology File
To start building a topology file, use the graphical tools to add and define the hosts
and components in the workspace. You can then assign the components to the
appropriate hosts.

This topic shows an example of the tasks required to create a topology file using
Fusion Middleware Composer. Specifically, this example provides step-by-step
instructions to create a topology for the Fusion Middleware multi-host environment
shown in Figure 2-3.

This topology contains two hosts (APPHOST1 and APPHOST2). APPHOST1 contains
the WebLogic Administration Server, a singe machine, and a single Managed Server,
while APPHOST2 contains a second machine and second Managed Server. A cluster is
shown encompassing both Managed Servers across both APPHOST1 and APPHOST2.
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Figure 2-3    Example of an Orace Fusion Middleware Multi Host Topology
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Table 2-3 provides an overview of the tasks required to create a topology file for a
multi-host environment.

Table 2-3    Tasks Required to Create a Topology File for a Multi Host Environment

No. Task Example

1 Create a new topology file. Creating a New Topology

2 Identify a wallet file that will be used
to hold environment credentials.

Loading a Wallet File

3 Add and define the hosts in your
environment.

Adding the Hosts

4 Add and define the Oracle home(s) in
your environment.

Adding the Oracle Home
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Table 2-3    (Cont.) Tasks Required to Create a Topology File for a Multi Host Environment

No. Task Example

5 Build and define the WebLogic
domain in your environment, which
typically includes an Administration
Server and a cluster of Managed
Servers.

Building the WebLogic Domain

6 Add and define the Node Managers
in your environment.

Adding the Node Managers

7 Assign/Map the components to the
appropriate hosts.

Assigning Components to Hosts

See Also:

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

2.3.4 Creating a New Topology
To start adding and defining items in the workspace, create a new topology file where
you will save configuration information about your environment. Every time you
make changes in the workspace, make sure to save your work to this file.

To create a new topology:

1. Select File > New.

You can also create a new topology by selecting the New Topology icon  on
the toolbar.

2. Click anywhere in the workspace in the Topology tab to display the Topology
Properties pane on the right.

3. In the Topology Properties pane, define the following properties:

Property Description

ID Enter a name for the topology file. For
example, my-topology.

Version Enter 1.0. This property allows you to
create different versions of a topology and
distinguish them from one another.

These properties are used to refer to this topology from other files or from tools
that use the topology.
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4. Select File > Save As... to save the file in any directory. The name of the file should
match the ID attribute. For example, my-topology.xml.

 

 

See Also:

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.5 Loading a Wallet File
Credentials that are used to connect to the environment and required to run
OPatchAuto, such as the credentials for connecting to the domain’s Administration
Server, must be stored and available in a separate wallet file. In Fusion Middleware
Composer, use the Settings page to load and edit an existing wallet file or to create a
new wallet.

1. Select File > Settings... to display the Settings page.
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2. On the Settings page, click change to provide the path to the wallet file.

3. In the dialog box, select Select an existing wallet to load the wallet you created in 
Creating a Wallet to Store Passwords and then click OK.

Alternatively, you can create a new wallet by selecting one of the following
options:

• Create a new wallet, which will create a wallet that does not require a
password.

• Create a new encrypted wallet, which will create a wallet that is password
protected.

An additional dialog box appears that prompts you to identify the wallet location.

4. Provide the wallet location and click Open to load the wallet.

5. After the wallet is loaded, click OK to dismiss the Settings page.

See Also:

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

Creating a Wallet to Store Passwords
To successfully run OPatchAuto, you must provide a wallet on the
command line that contains the necessary password credentials for
connecting to the environment.

2.3.6 Adding the Hosts
Building a topology in Fusion Middleware Composer starts with creating a host,
which is a physical or virtual machine that can be associated with an Oracle home and
domain. A host is defined in the topology by its IP address.

To add the hosts to the topology:

1. Select Edit > Add New Host.
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Alternatively, you can select the Add New Item icon  on the toolbar, select
Add New Host in the dialog box, and then click OK.

A new host (host1) is created in the workspace.

2. Select the host object you just created, and define the following attributes for the
host:

Attribute Description

ID Keep the default value, host1. The ID attribute is an identifier that is
used to refer to this host from other parts of the topology.

Address Enter the listen address for Host host1.

Credential This attribute is used to identify the credential in the wallet file that
will be used to connect to the host.

Click select to select the credential for the host from the wallet file you
loaded in Loading a Wallet File. When you click select, a dialog box
appears that lists the credentials in the given wallet.

If the credential already exists in the wallet, select the appropriate
credential from the list and click OK. If the credential does not exist in
the wallet, click New to add the host credential to the wallet and to
provide an alias for this credential.

3. Repeat this process to add a second host, host2, to the topology.

After you add and define the hosts, your workspace should look similar to the
following example:
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See Also:

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.7 Adding the Oracle Home
After you create and define the hosts, add and define the Oracle home(s) available in
the environment. To define an Oracle home, you must provide the absolute path to the
Oracle home directory.

To add and define an Oracle home:

1. Click anywhere in the workspace in the Topology tab.
Ensure that the existing topology objects in the workspace are not selected.

2. Select Edit > Add New Oracle Home.

Alternatively, you can select the Add New Item icon  on the toolbar, select
Add New Oracle Home in the dialog box, and then click OK.

An Oracle home (home1) is created in the workspace.

3. Select the Oracle home object you just created, and define the following attributes
for the Oracle home:

Attribute Description

ID Keep the default value, home1. The ID attribute is an identifier that is
used to refer to this Oracle home from other parts of the topology.

Type Select shared, which defines that the Oracle home is on shared storage.
If your Oracle home is on local storage, select local .

This information is used to determine how many copies of the Oracle
home there are in the environment, which is important when applying
a patch to the Oracle home.

If there are copies of the Oracle home on multiple hosts, each Oracle
home should be defined individually, and the Type attribute should
be local for each one. Only use shared if the Oracle home is on shared
disk that is mounted on more than one host.

Path Enter the full path to the Oracle home that is being patched.

After you add and define the Oracle home, your workspace should look similar to the
following example:
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See Also:

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.8 Building the WebLogic Domain
For a multi-host environment, you need to build and define a WebLogic domain,
which typically includes an Administration Server and a cluster of Managed Servers.

Building the WebLogic domain includes the following steps:

See Also:

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
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allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

Add and Define a Domain
Before you define the servers in the topology, add and define the
domain. To define a domain, you must provide the absolute path to the
domain home location on a given host.

Add and Define the WebLogic Administration Server
After you create and define the domain, add the WebLogic
Administration Server to the domain in the topology.

Add and Define a Cluster
Before you can add Managed Servers to the domain, you must add and
define the cluster where the Managed Servers are running.

Add and Define the Managed Servers
After you have created and defined the domain and a cluster in your
topology, assign the Managed Servers to the cluster in the domain.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.8.1 Add and Define a Domain
Before you define the servers in the topology, add and define the domain. To define a
domain, you must provide the absolute path to the domain home location on a given
host.

To add and define a domain:

1. Click anywhere in the workspace in the Topology tab.
Ensure that the existing topology objects in the workspace are not selected.

2. Select Edit > Add New Domain to add a domain to the workspace.

Alternatively, you can select the Add New Item icon  on the toolbar, select
Add New Domain in the dialog box, and then click OK.

A new domain object (domain1) is created in the workspace.

3. Select the domain object that you just created, and define the following Attributes
for the domain:

Attribute Description

ID Keep the default value, domain1. The ID attribute is an identifier that
is used to refer to this domain from other parts of the topology.

Name Enter the name of the domain. This attribute should match the name
provided during domain configuration.

Type Select shared to indicate that the domain is on shared storage. If your
domain is on local storage, select local .

Path Enter the full path to the Domain home that is being patched.
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Attribute Description

Admin
Credential

This attribute is used to identify the credential in the wallet file that
will be used to connect to the domain’s Administration Server.

Click select to select the credential for the Administration Server from
the wallet file you loaded in Loading a Wallet File. When you click
select, a dialog box appears that lists the credentials in the given
wallet.

If the credential already exists in the wallet, select the appropriate
credential from the list and click OK. If the credential does not exist in
the wallet, click New to add the Administration Server credential to
the wallet and to provide an alias for this credential.

Admin Server
Url

Enter the URL that is used to connect to the WebLogic Administration
Server. For example, t3://
examplehost.exampledomain.com:7001.

After you have added and defined a domain, your workspace should look similar to
the following example:
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See Also:

Building the WebLogic Domain
For a multi-host environment, you need to build and define a WebLogic
domain, which typically includes an Administration Server and a cluster
of Managed Servers.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.8.2 Add and Define the WebLogic Administration Server
After you create and define the domain, add the WebLogic Administration Server to
the domain in the topology.

To add the WebLogic Administration Server to the domain:

1. Select the domain object in the workspace, and then select Edit > Add New Server
to Domain ‘domain1’ to add the Administration Server.

Alternatively, you can select the Add New Item icon  on the toolbar, select
Add New Server to Domain ‘domain1’ in the dialog box, and click OK.

A new server (server1) is added to the domain in the workspace.

2. Select the server1 object you just created, and define the following Attributes for
the Administration Server:

Attribute Description

ID Keep the default value, server1. The ID attribute is an identifier that is
used to refer to this server from other parts of the topology.

Is Admin Server Select the Is Admin Server check box to identify this server as the
Administration Server.

Name Enter a name for the Administration Server. For example,
AdminServer.

Listen Address Enter the listen address of the Administration Server.

Listen Port Enter the listen port of the Administration Server. For example, 7001.

After you added and defined the Administration Server, your workspace should look
similar to the following example:
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See Also:

Building the WebLogic Domain
For a multi-host environment, you need to build and define a WebLogic
domain, which typically includes an Administration Server and a cluster
of Managed Servers.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.8.3 Add and Define a Cluster
Before you can add Managed Servers to the domain, you must add and define the
cluster where the Managed Servers are running.

To add a cluster to the topology:

1. Select the domain object in the workspace, and then select Edit > Add New Cluster
to Domain ‘domain1’ to add a cluster to the workspace.

Alternatively, you can select the Add New Item icon  on the toolbar, select
Add New Cluster to Domain ‘domain1’ in the dialog box, and click OK.

A new cluster (cluster1) is added to the domain in the workspace.

2. Select the cluster1 object you just created, and define the following Attributes for
the cluster:

Attribute Description

ID Keep the default value, cluster1. The ID attribute is an identifier that is
used to refer to this cluster from other parts of the topology.
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Attribute Description

Name Enter the name of the cluster.

After you have added and defined a cluster, your workspace should look similar to
the following example:

See Also:

Building the WebLogic Domain
For a multi-host environment, you need to build and define a WebLogic
domain, which typically includes an Administration Server and a cluster
of Managed Servers.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.8.4 Add and Define the Managed Servers
After you have created and defined the domain and a cluster in your topology, assign
the Managed Servers to the cluster in the domain.

To add Managed Servers to a cluster:

1. Select the cluster object in the workspace, and then select Edit > Add New Server
to Cluster ‘cluster1’.

Alternatively, you can select the Add New Item icon  on the toolbar to add a
Managed Server to the cluster.

A new server (server2) is created in the workspace.

2. Define the following Attributes for the Managed Server:
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Attribute Description

ID Keep the default value, server2. The ID attribute is an identifier that is
used to refer to this server from other parts of the topology.

Name Enter a name for the Managed Server. For example,
managed_server1.

Listen Address Enter the listen address of the Managed Server.

Listen Port Enter the listen port of the Managed Server.

3. Repeat this process to add a second Managed Server, server3, to the cluster.

After you have added and defined the Managed Servers, your workspace should look
similar to the following example:
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See Also:

Building the WebLogic Domain
For a multi-host environment, you need to build and define a WebLogic
domain, which typically includes an Administration Server and a cluster
of Managed Servers.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.9 Adding the Node Managers
If you have Node Managers being used in the environment, each Node Manager has
to be defined in the topology file.

1. Click anywhere in the workspace in the Topology tab.
Ensure that the existing topology objects in the workspace are not selected.

2. Select Edit > Add New Node Manager to add a Node Manager to the workspace.

Alternatively, you can select the Add New Item tool  on the toolbar, select
Add New Node Manager in the dialog box, and click OK.

A Node Manager (nm1) is created in the workspace.

3. Select the Node Manager object you just created, and define the following
attributes for the Node Manager:

Attribute Description

ID Keep the default value, nm1. The ID attribute is an identifier that is
used to refer to this Node Manager from other parts of the topology.

Name Enter the name of the Node Manager. This attribute should match the
name provided during domain configuration. For example, Machine
1.

Credential This attribute is used to identify the credential in the wallet file that
will be used to connect to the Node Manager.

Click select to select the credential for the Node Manager from the
wallet file you loaded in Loading a Wallet File. When you click select,
a dialog box appears that lists the credentials in the given wallet.

If the credential already exists in the wallet, select the appropriate
credential from the list and click OK. If the credential does not exist in
the wallet, click New to add the Node Manager credential to the wallet
and to provide an alias for this credential.

NmAddress Under Tuning Parameter Settings, click the Add New Item icon 
to add a value for the Node Manager listen address (NmAddress)
attribute.

When you click this icon, a dialog box appears. For Name, select
NmAddress from the drop-down menu, and then enter the Node
Manager listen address in the Value field.
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Attribute Description

NmPort Under Tuning Parameter Settings, click the Add New Item icon 
to add a value for the Node Manager listen port (NmPort) attribute.

When you click this icon, a dialog box appears. For Name, select
NmPort from the drop-down menu, and then enter the Node Manager
listen port in the Value field (for example, 5556).

4. Repeat this process to add and define a second Node Manager, nm2.

After you have added and defined the Node Managers, your workspace should look
similar to the following example:

See Also:

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
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allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.10 Assigning Components to Hosts
After all the components in the environment have been defined, map the components
on the right side of the Fusion Middleware Composer workspace to the appropriate
hosts on the left to finish building the topology.

Note:   

The examples in this section show you how to use the Assign Existing Item

tool  on the toolbar to complete this task. You can also use the drag and
drop feature to assign components to the hosts. You do this by clicking and
holding down the mouse button over an item on the right side of the
workspace, dragging it to the appropriate location in the hosts on the left, and
then releasing the mouse button to drop it.

For more information, see the following tasks:

See Also:

Building A Topology Using Fusion Middleware Composer
For multi-host patching, a prerequisite is to define your configuration in
a topology file. Use Fusion Middleware Composer to create this file and
provide information about your environment to OPatchAuto. This file
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allows OPatchAuto to identify the topology you want to patch and
automatically perform the patching steps without manual intervention.

Assigning the Oracle Home to Hosts
After you create the Oracle home, assign the Oracle home (home1) to the
appropriate hosts (host1 and host2) in the topology.

Assigning the Domain to Hosts
After you create the domain and assign the Oracle home to the hosts,
assign the domain (domain1) to the hosts (host1 and host2) in the
topology.

Assigning the Administration Server to a Host
After you create the Administration Server and assign the domain to the
hosts, assign the Administration Server (server1) to a host (host1) in the
topology.

Assigning Node Managers to Hosts
After you create the Node Managers and assign the domain to the hosts,
assign the Node Managers (nm1 and nm2) to the appropriate hosts
(host1 and host2) in the topology.

Assigning Managed Servers to Hosts
After you create the Managed Servers and assign the domain to the
hosts, assign the Managed Servers (server2 and server3) to the
appropriate hosts (host1 and host2) in the topology.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.10.1 Assigning the Oracle Home to Hosts
After you create the Oracle home, assign the Oracle home (home1) to the appropriate
hosts (host1 and host2) in the topology.

To assign the Oracle home to the hosts:

1. Select the Host host1 object in the workspace, and then select  on the toolbar.

2. In the dialog box, select the Oracle home (home1) to add to Host host1 and click
OK.

3. Repeat this process to assign the Oracle home to Host host2.

After you assign the Oracle home to both hosts, your workspace should look similar to
the following example:
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See Also:

Assigning Components to Hosts
After all the components in the environment have been defined, map the
components on the right side of the Fusion Middleware Composer
workspace to the appropriate hosts on the left to finish building the
topology.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.10.2 Assigning the Domain to Hosts
After you create the domain and assign the Oracle home to the hosts, assign the
domain (domain1) to the hosts (host1 and host2) in the topology.

To assign the domain to hosts:

1. Select the Oracle home object in Host host1, and then select  on the toolbar.

2. In the dialog box, select the domain (domain1) to add to Oracle Home home1 and
click OK.

3. Repeat this process to assign the domain (domain1) to the Oracle home in Host
host2.

After you assign the domain to both hosts, your workspace should look similar to the
following example:
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See Also:

Assigning Components to Hosts
After all the components in the environment have been defined, map the
components on the right side of the Fusion Middleware Composer
workspace to the appropriate hosts on the left to finish building the
topology.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.10.3 Assigning the Administration Server to a Host
After you create the Administration Server and assign the domain to the hosts, assign
the Administration Server (server1) to a host (host1) in the topology.

To assign an Administration Server to a host:

1. Select the domain object in Host host1, and then select  on the toolbar.

2. In the dialog box, select Assign Existing Servers for Domain ‘domain1’ to Host
‘host1’ (home1)... and click OK.

An additional dialog box appears that lists the servers you can assign to the host.

3. Select the server (server1) to assign to Host host1 and click OK.

After you assign the Administration Server to a host, your workspace should look
similar to the following example:
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See Also:

Assigning Components to Hosts
After all the components in the environment have been defined, map the
components on the right side of the Fusion Middleware Composer
workspace to the appropriate hosts on the left to finish building the
topology.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.10.4 Assigning Node Managers to Hosts
After you create the Node Managers and assign the domain to the hosts, assign the
Node Managers (nm1 and nm2) to the appropriate hosts (host1 and host2) in the
topology.

To assign Node Managers to hosts:

1. Select the domain object in Host host1, and then select  on the toolbar.

2. In the dialog box, select Assign Existing Node Manager to Domain ‘domain1’...
and click OK.

An additional dialog box appears that lists the Node Managers you can assign to
the host.

3. Select the Node Manager (nm1) to assign to Host host1 and click OK.

4. Repeat this process to assign the second Node Manager (nm2) to the domain on
Host host2.
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After you assign the Node Managers to the domain on both hosts, your workspace
should look similar to the following example:
 

 

See Also:

Assigning Components to Hosts
After all the components in the environment have been defined, map the
components on the right side of the Fusion Middleware Composer
workspace to the appropriate hosts on the left to finish building the
topology.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.

2.3.10.5 Assigning Managed Servers to Hosts
After you create the Managed Servers and assign the domain to the hosts, assign the
Managed Servers (server2 and server3) to the appropriate hosts (host1 and host2) in
the topology.

To assign Managed Servers to hosts:

1. Select the domain object in Host host1, and then select  on the toolbar.

2. In the dialog box, select Assign Existing Servers for Domain ‘domain1’ to Host
‘host1’ (home1)... and click OK.

3. Select the server (server2) to assign to Host host1 and click OK.

4. Repeat this process to assign the second Managed Server (server3) to the domain
on Host host2.
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After you assign the Managed Servers to the domain on the appropriate hosts, your
workspace should look similar to the following example:

 

 

See Also:

Assigning Components to Hosts
After all the components in the environment have been defined, map the
components on the right side of the Fusion Middleware Composer
workspace to the appropriate hosts on the left to finish building the
topology.

Example of Building a Topology File
To start building a topology file, use the graphical tools to add and
define the hosts and components in the workspace. You can then assign
the components to the appropriate hosts.
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